
 

 

Introduction 

NXPowerLiteTM radically reduces the size of your 
Microsoft® PowerPoint® files. It's fast, effective and 
incredibly easy to use. 

With NXPowerLite, you can focus on creating a great 
presentation. There's no need to manually tweak your 
images or flatten any embedded objects, saving you a 
great deal of time and effort.  

System Requirements 

Stand-Alone Edition: Microsoft® Windows® NT4,   
2000, XP or Vista. 

Integrated Edition: Microsoft® Windows® 98, ME, NT4, 
2000, XP or Vista. 

NXPowerLite can optimize presentations created using 
any version of Microsoft® PowerPoint®  from 
PowerPoint® 97, as well as StarOffice® and 
OpenOffice.org presentations saved in the PPT format.  
Please note that the current edition of NXPowerLite 
cannot optimize presentations saved in Office 2007’s 
new PPTX format. 

The Integrated Edition of NXPowerLite will integrate with 
all versions of PowerPoint® from PowerPoint® 2000 and 
all versions of Outlook® from Outlook® 2000. 

A Server Edition  of NXPowerLite is also available.  It 
has no Graphical User Interface, but can be scripted 
from any environment that supports COM components 
(such as ASP or Windows® Scripting Host).  For Server 
Edition documentation, please contact 
support@nxpowerlite.com. 

Installation 

Stand-Alone Edition:  Unlike most applications, the 
Stand-Alone Edition of NXPowerLite (NXPowerLite.exe) 
is a self-contained program that does not need to be 
installed.  

Integrated Edition: The Integrated Edition of 
NXPowerLite (nxplite_25.exe) requires installation.  
Simply double-click on the installation file and follow the 
on-screen instructions. 

 

 

Starting NXPowerLite 

To start NXPowerLite, simply double-click its icon. 

If you have not yet registered NXPowerLite, you will see 
a screen reminding you to register; just click ‘Continue’ 
to proceed to the main NXPowerLite window. 

Alternatively, you can start NXPowerLite by dragging 
one or more PowerPoint® files onto the NXPowerLite 
icon. 

NXPowerLite will automatically start with the file details 
selected and ready to optimize. 

Using NXPowerLite 

The main NXPowerLite window looks like this: 

 

You can select presentations to optimize by clicking the 
‘Add Files…’ button, or by choosing from a list of 
recently opened presentations in the 'File' menu.  You 
can also select all presentations in a folder by clicking 
the 'Add Folder...” button.  To remove a presentation 
from the list, select the presentation and click on the 
'Remove' button (which will become active as soon as a 
presentation is selected). 



NXPowerLite will automatically choose a filename for 
your optimized presentations, but you can change this. 

To start optimizing presentations, click the ‘Optimize’ 
button. While presentations are being optimized, you will 
see a window containing a progress bar and estimate of 
time remaining: 

 

The 'Cancel' button can be used to cancel the 
optimization process at any time. 

While a presentation is being optimized, you may see 
this message: 

 

NXPowerLite is able to ‘flatten embedded 
documents ', such as Microsoft® Excel® charts, by 
converting them into pictures. Doing this can reduce the 
size of your presentation considerably, but the 
embedded documents can no longer be double-clicked 
and edited in the application that created them. 

Generally, unless you think that you (or the recipient of 
your presentation) will need to edit the embedded 
document, we suggest you answer “Yes” to this 
question. 

When NXPowerLite has finished optimizing your 
presentations, you will be shown a summary of the 
results, including the percentage reduction in size that 
has been achieved: 

 

You can then opt to email the presentation to somebody 
using your default email program, by clicking the 'Email' 
button.  If the optimized presentation is still too large to 
email, click on the 'Zip & Email button' to zip the 
optimized presentation and reduce the file size further. 

Right-clicking on a presentation reveals further options.  
You can open the presentation, delete it or find out 
more information about it.  These options can also be 
found under the 'File' menu. 

Batch Processing 

If you select more than one presentation to optimize by 
using the 'Add Files...' or 'Add Folder...' buttons, you 
enter batch processing mode. 

When you click the 'Optimize' button, a new 'Batch 
Processing' window will appear: 

 

'Flatten embedded documents ', if ticked, will flatten all 
embedded objects in every presentation within your 
batch. 

 



'Overwrite optimized files if they already exist ',         
if ticked, will automatically overwrite any optimized 
versions of presentations in your batch, should they 
have already been optimized on a prior occasion. 

'Save optimized files in: ' enables you to choose 
whether to save optimized presentations in the same 
folder as the originals, or in a single, new folder.  If you 
choose 'Single folder', the 'Copy files that don't 
optimize to this folder ' option becomes active.  Tick 
this option to copy any presentations that did not 
optimize successfully to the new folder automatically.  
This will ensure that the new folder contains a copy of 
every presentation in your batch, whether it optimized 
successfully or not. 

Compression Levels 

To select a compression level, simply click on the drop-
down list in the 'Compression level' section of the main 
window. 

When NXPowerLite is first run, the default compression 
level is ‘Normal compression ’. This works well when a 
presentation is to be viewed on a high resolution 
monitor or using a projector.  Presentations optimized 
using normal compression will look great on almost all 
types of display. 

Choose 'Extra compression ' if your presentation needs 
to be as small as possible - to fit on a floppy disk, email 
to somebody with a dial-up connection or view on a 
mobile phone or PDA.  While this compression level 
produces the smallest file sizes, pictures may look less 
sharp on larger displays. This mode also looks for 
pictures cropped using PowerPoint®’s cropping tool, and 
does not save the cropped areas of images in the 
optimized presentation. 

If you expect your presentation to be printed in full 
colour with one slide to a page, you might want to select 
‘High quality compression ’. This prevents 
NXPowerLite from resizing any pictures in the 
presentation. The downside of this compression level is 
that the resulting presentation files are likely to be 
significantly larger than with the other compression 
levels. 

If your presentation is designed to be viewed on a 
mobile device such as a telephone or PDA, you can 
choose 'Mobile device compression '.  This will 
achieve very high compression rates by optimizing for 
the small screen of a mobile device.  This setting is 
useful when sending presentations to a mobile device, 
which will typically have a much slower connection to 
the Internet.  However, the quality of the presentation 
will appear poor on larger displays. 

 

 

 

 

Custom Compression Settings 

For even more control over NXPowerLite’s behaviour, 
you can choose ‘Custom compression ’. When this 
option is selected, the 'Settings' button next to the 
'Compression level' drop-down list becomes active.  
Clicking this button opens the Compression Settings 
window: 

 

If 'Allow JPEG compression ' is enabled, NXPowerLite 
will use JPEG compression wherever it is appropriate to 
do so. Generally speaking, any photographs in your 
presentation should be compressed using this method. 
If your presentation contains this type of image, turning 
JPEG compression off will result in a much larger file. 

Adjusting the JPEG quality  will affect the size of your 
files, but also the quality of the JPEG pictures contained 
in your presentation (higher quality will generally result 
in a presentation with a larger file size, but better looking 
pictures). We find that the default JPEG quality setting 
of ‘6’ offers the best trade-off between size and quality. 

If you use PowerPoint®’s ‘crop’ feature, the whole of 
your original picture, including any portions that you 
have cropped off, is still saved within the presentation. 
'Allow  image cropping'  enables NXPowerLite to 
remove any portions of pictures that you have cropped 
within PowerPoint®. This will reduce the size of your file, 
but bear in mind that the removed portions of pictures 
will not be recoverable in the optimized presentation. 

When creating a presentation, it is possible to import a 
very large picture into PowerPoint® and scale it down to 
fit onto the slide. When this occurs, PowerPoint® saves 
all the details of the large picture, even if those details 
are not visible when the presentation is shown.  'Allow  
image resizing'  enables NXPowerLite to resize large 
pictures so that smaller versions are saved within your 
presentation, reducing the size of the resulting file. 

The 'Optimize images for display at: ' drop-down list 
should display the screen resolution that you expect 
your presentation to shown at.  The default resolution of 
1024 x 768 pixels is suitable for most purposes, but 
resized pictures may look ‘blurred’ when printed or 
viewed at higher resolutions.  If your preferred resolution 
is not shown in the list, the 'Custom' button will allow you 
to enter a custom resolution. 

 

 



 

Additional options 

By selecting 'Options' from the 'Tools' menu, you can 
access additional NXPowerLite options: 

 

You can choose whether to always flatten embedded 
objects , never flatten them or ask on a presentation-by-
presentation basis. 

You can also edit the text that is automatically added to 
your optimized presentation filenames .  By default, 
NXPowerLite adds the word 'NXPowerLite' in brackets 
after the original filename. 

Additionally, you can choose to 'preserve original file's 
date and time '.  This will give your optimized 
presentation the same date and time as the original 
presentation, rather than the date and time that the 
presentation was optimized. 

NXPowerLite Integrated Edition 

The Integrated Edition of NXPowerLite enables you to 
access NXPowerLite from PowerPoint®’s ‘File’ menu, or 
by right-clicking a presentation in Windows® Explorer.  It 
also allows you to automatically optimize presentations 
before emailing them using Microsoft® Outlook®. 

The first time your use the Integrated Edition, it will take 
you through a 'wizard-style' setup process: 

 

Initially, it will ask you whether you would like to install 
the Integrated Edition of NXPowerLite purely for 
yourself, or for everybody that uses your computer 
(unlike the stand-alone version of NXPowerLite, the 
Integrated Edition requires installation). 

It will then ask which components you would like to 
install. 

If you install PowerPoint ® Integration , an 'Optimize 
with NXPowerLite option will be added to PowerPoint®'s 
'File' menu (PowerPoint® 2000-2003) or ‘Add-ins’ tab 
(PowerPoint® 2007). 

If you install Outlook ® Integration , whenever you 
attach a presentation to an email Outlook® will ask if you 
want to optimize it before sending.  If you choose 'Yes', 
the presentation will be optimized using your current 
NXPowerLite settings.  You can change the behaviour 
of Outlook® so that is always automatically optimizes 
presentations before sending, or never optimizes them.  
To do this, select the appropriate option from the 
'Optimize attachments with NXPowerLite' submenu, 
which you'll find under Outlook®'s 'Tools' menu when 
composing an email (or the ‘Add-ins’ tab in Outlook® 
2007). 

If you install Explorer Integration , you will be able to 
start NXPowerLite from the right-click menu within 
Windows® Explorer. 

If you install the Desktop Shortcut , a shortcut to 
NXPowerLite will appear on the Windows® Desktop. 

To uninstall any or all of these components, select 
'NXPowerLite' from the 'Add/Remove programs' window 
in the Windows® Control Panel. 

Support 

NXPowerLite is extremely user-friendly. However, if you 
have any questions or experience technical difficulties, 
please visit the support pages at the NXPowerLite 
website (www.nxpowerlite.com). 

If this doesn’t resolve your problem, registered users 
can use our email support service by either filling in the 
support form on the website or contacting 
support@nxpowerlite.com. 

 


